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ABSTRACT 

 

The development of the use generated by microcontroller technology is worthy of 

use in the cultivation of chili plants. One way of harnessing is by devising a 

control system in the drip irrigation system. In his designed irrigation system 

drops in control with arduino uno to display the tools to work properly. The 

water's surface distance system to the HC-SR04 sensors is produced that at a 

distance of 20 cm to 25 cm the yellow LED light is on and the green LED light is 

off and from 4 cm to 6 cm the yellow LED light is off and the green LED light is 

on. The design suggests that the irrigation system of drops can automatically 

control the volume of water into shelters so that water is always available in 

reservoirs that are useful to aliri to the installation of a pipe to drop water on a 

pepper plant. 

  

Keywords : Arduino Uno, HC-SR04 Sensors, Led Lights, Chili Plants. 
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ABSTRAK 

 

Perkembangan pemanfaatan yang bersumber dari teknologi mikrokontroler layak 
digunakan pada budidaya tanaman cabai. Salah satu cara dalam pemanfaatan 
dengan merancang sistem pengontrolan pada sistem irigasi tetes. Dalam 
rancangannya sistem irigasi tetes di kontrol dengan arduino uno untuk 
menampilkan alat bekerja dengan baik. Sistem kerja jarak permukaan air terhadap 
sensor HC-SR04 dihasilkan bahwa pada jarak 20 cm hingga 25 cm maka lampu 
LED kuning menyala dan lampu LED hijau mati dan pada jarak 4 cm hingga 6 cm 
lampu LED kuning mati dan lampu LED hijau menyala. Berdasarkan rancangan 
tersebut terdapat bahwa sistem irigasi tetes dapat mengendalikan volume air 
secara otomatis ke dalam penampungan sehingga air selalu tersedia di dalam 
penampungan yang berguna untuk di aliri ke instalasi pipa untuk meneteskan air 
pada tanaman cabai. 

 

Kata kunci : Arduino uno, Sensor HC-SR04, Lampu LED, Tanaman Cabai. 
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BAB I 

PENDAHULUAN 

 

1.1. Latar Belakang 

Salah satu kebutuhan setiap tanaman yang harus dipenuhi tentunya adalah 

air. Untuk memenuhi kebutuhan itu maka perlu dilakukan yang namanya 

pengairan atau irigasi. Endang Andi Juhana et al. (2015) berpendapat, “Pengairan 

atau irigasi adalah usaha pemberian air dan pengaturan air pada tanaman untuk 

menunjang kualitas ataupun produktifitas pertanian.” 

Salah satu model sistem irigasi yang berkembang saat ini adalah irigasi 

tetes. Irigasi tetes merupakan salah satu teknologi irigasi yang bertujuan 

memanfaatkan ketersedian air yang sangat terbatas secara efisien dan 

meningkatkan nilai pendayagunaan air. Prinsip pendistribusian air pada sistem 

irigasi tetes adalah dengan menyalurkan air dari tangki atau botol penampung 

yang diletakkan pada posisi yang lebih tinggi dari lahan pertanian, melalui pipa 

irigasi. Kebutuhan air tanaman dipasok dari tangki atau botol penampungan 

melalui pipa irigasi yang didesain sesuai kebutuhan sehingga air dapat diberikan 

dengan debit yang sama dan konstan pada setiap titik keluaran selang irigasi 

menggunakan sistem tetes pada daerah perakaran tanaman. 

Teknik pemberian irigasi pada tanaman perlu juga memperhatikan 

ketersediaan air untuk disalurkan pada tanaman tersebut, oleh karena itu 

diperlukan sebuah sistem pengontrolan pada pemberian air irigasi melalui wadah 

penampungan airnya untuk mencegah tejadinya kekurangan air. Salah satu cara 

pengontrolan irigasi tersebut adalah dengan cara penerapan sistem kendali dengan 
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komponen pendukung lainnya pada sistem irigasi. Berdasarkan uraian di atas, 

perlu dilakukan penelitian ini.  

1.2. Perumusan Masalah 

 Adapun yang menjadi rumusan masalah dalam penelitian ini adalah : 

1. Apakah sistem kendali otomatis pengatur volume air pada botol sistem 

irigasi tetes tanaman cabai dapat dibuat sesuai kebutuhan ? 

2. Variabel apakah yang diatur pada alat sistem irigasi sehingga disebut 

bekerja dengan otomatis ? 

3. Apakah yang diuji pada rancangan alat ? 

4. Sensor apa yang sesuai untuk kebutuhan deteksi kesediaan air pada botol 

penampungan air ? 

1.3. Batasan Masalah 

Yang menjadi batasan masalah dalam penelitian ini adalah : 

1. Sistem kendali yang digunakan adalah sistem Arduino Uno. 

2. Penelitian ini hanya mengkaji pada sistem pengendalian secara elektronik 

saja dan bukan mengkaji bagaimana dampak penggunaan alat terhadap 

kesuburan tanaman. 

3. Jenis tanaman yang digunakan sebagai contoh pada penelitian adalah cabai 

rawit dengan alasan mudah didapatkan. 

4. Untuk pengendalian kelembaban tanah tidak dilakukan melalui integrasi 

rancangan alat namun dilakukan secara terpisah ataupun manual dengan 

alasan agar efektif pada penggunaan tanaman lahan yang luas. 
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1.4. Tujuan Penelitian  

Tujuan dari penelitian ini adalah  

1. Merancang dan membuat sistem kendali otomatis pengatur volume air 

pada botol penampungan sistem irigasi tetes tanaman cabai menggunakan 

sistem kendali Arduino. 

2.  Mengatur kerja on/off pompa berdasarkan volume air pada botol 

penampungan melalui pendeteksian jarak permukaan air terhadap sensor. 

3. Melakukan pengujian terhadap sistem kerja dari setiap komponen 

pembentuk alat serta menguji kinerja alat secara keseluruhan terhadap 

fungsi sebagai pengendali irigasi tetes.  

4. Mengaplikasikan sensor ultrasonik HC-SR04 sebagai alat pendeteksi 

volume air melalui jarak permukaan air terhadap muka sensor.  

 
1.5. Manfaat Penelitian 

Dari penelitian ini diharapkan dapat memberikan manfaat sebagai berikut: 

1. Dapat meningkatkan nilai guna air terhadap tanaman. 

2. Hemat air untuk pengairan karena penggunaan air yang sesuai dengan 

kebutuhan tanaman saja, tidak mengalirkan air ke semua area. 

3. Hemat tenaga karena dengan penggunaan sistem irigasi otomatis ini 

melakukan pengisian air ke dalam botol atau tangki penampungan secara 

otomatis. 

4. Hemat waktu karena pengaturan pada sistem otomatis irigasi tetes ini bisa 

efisien sehingga mengurangi waktu pada penyiraman. 
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5. Dapat mengurangi tingkat kekhawatiran terhadap ketersediaan air pada 

tanaman, apalagi kondisi lahannya sering ditinggalkan dalam waktu yang 

lama. 

 
1.6. Sistematika Pembahasan 

Sistematika penulisan pada masing-masing bab adalah sebagai berikut : 

1. Bab I Pendahuluan  

Menjelaskan secara singkat tentang latar belakang penelitian, rumusan 

masalah penelitian, batasan masalah, tujuan dan manfaat penelitian serta 

sistematika penulisan. 

2. Bab II Teori Penunjang 

Bab ini membahas tentang teori-teori pendukung dalam penelitian ini 

sehingga hasil yang didapatkan lebih optimal.  

3. Bab III Metode Perancangan 

Membuat tentang benda kerja yang mau dirancang, waktu dan tempat 

penelitian, serta pelaksanaan penelitian yang terdiri dari persiapan alat 

yang mau dibuat, dan prosedur pembuatan alat. 

4. Bab IV Pengujian dan Analisis 

Bab ini membahas tentang bentuk atau langkah pengujian alat yang 

dirancang serta menganalisis kembali hasilnya agar didapatkan suatu 

rangkuman ataupun kesimpulan dan saran yang membangun. 

5. Bab V Kesimpulan dan Saran  

Bab ini menguraikan kesimpulan dari analisa data hasil penelitian dan 

saran-saran untuk pembahasan selanjutnya. 
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BAB II 

TEORI PENUNJANG 

 

2.1. Teknologi Irigasi Tetes 

 Irigasi tetes adalah suatu teknik pemberian air melalui pipa atau selang 

berlubang dengan menggunakan tekanan tertentu, dimana air yang keluar berupa 

tetesan-tetesan langsung pada daerah perakaran tanaman. Tujuan dari irigasi tetes 

adalah untuk memenuhi kebutuhan air tanaman tanpa harus membasahi 

keseluruhan lahan, sehingga mereduksi kehilangan air akibat penguapan yang 

berlebihan. (Hansen, 1986) 

 Aliran air pada irigasi tetes memanfaatkan gaya kapilaritas dan gravitasi 

yang bergerak secara vertical dan horizontal dalam profil tanah. (Hansen et al, 

1992). Pemberian air dalam volume kecil dan berkelanjutan melalui irigasi tetes 

bertujuan untuk menjaga kelembaban tanah dan terhindar dari kehilangan seperti 

perkolasi dan limpasan sehingga ketersediaan air bagi tanaman terpenuhi. 

Komponen penyusun sistem irigasi tetes terdiri dari sumber air, pompa dan tenaga 

penggerak, jaringan pipa saluran air. Jaringan pipa irigasi tetes terdiri dari emiter 

(penetes), pipa lateral, pipa sub utama (manifold), pipa utama dan komponen 

pendukung. (Dirjen PLA, 2008) 

 Emiter berfungsi sebagai komponen yang menyalurkan air dari pipa lateral 

ke tanah secara berkelanjutan dengan debit rendah dan tekanan mendekati tekanan 

atmosfer. Pipa lateral berfungsi sebagai tempat diletakkan emiter yang biasanya 

terbuat dari pipa jenis PVC atau PE. Pipa sub utama berfungsi sebagai penyalur 

air ke pipa lateral. Pipa utama berfungsi sebagai penyalur air dari sumber air ke 
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pipa distribusi dalam jaringan yang dapat dipasang di atas atau permukaan tanah. 

Komponen pendukung terdiri dari katup-katup, saringan, pengatur tekanan dan 

debit, tangki bahan kimia dan lain sebagainya. (Dirjen PLA, 2008) 

 

 

Gambar 2.1 : Sistem Irigasi Tetes Gravitasi. 

https://domvizit.ru/id/cottage/drip-irrigation-for-high-pressure-with-your-hands-drip-irrigation-
system-we-create-from-improvised-materials/ 

  

2.2. Arduino 

Menurut Setiawardhana, dkk (2019:1), arduino merupakan perangkat 

elektronik yang berfungsi seperti mikrokontroler dan bersifat open source. 

hardware arduino sama dengan microcontroller pada umumnya hanya pada 

arduino ditambahkan penamaan pin agar mudah diingat. Software arduino 

merupakan software open source sehingga dapat di download secara gratis. 

Software ini digunakan untuk membuat dan memasukkan kode program ke dalam 

arduino. Pemrograman arduino tidak sebanyak tahapan mikrokontroler 

konvensional karena arduino sudah di desain supaya lebih mudah dipelajari, 

sehingga para pemula dapat mulai belajar mikrokontroler dengan arduino. 

Berdasarkan uraian diatas, dapat disimpulkan bahwa arduino merupakan platform 
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pembuatan prototipe elektronik yang terdiri dari hardware dan software. 

Arduino pada awalnya dikembangkan di Ivrea, Italia. Nama arduino 

adalah sebuah nama maskulin yang berarti teman yang kuat. Platform arduino 

terdiri dari arduino board, shield, bahasa pemrograman arduino, dan arduino 

development environment. Arduino board biasanya memiliki sebuah chip dasar 

mikrokontroler Atmel AVR ATmega8 berikut turunannya. Blok diagram Arduino 

board yang sudah di sederhanakan dapat dilihat pada Gambar 2.2. Shield adalah 

sebuah papan yang dapat dipasang diatas arduino board untuk menambah 

kemampuan dari arduino board. 

Penjelasan lain juga menyatakan bahwa Arduino adalah sebuah platform 

elektronik yang bersifat open source serta mudah digunakan. Hal tersebut 

ditujukan agar siapapun dapat membuat proyek interaktif dengan mudah dan 

menarik. (Wicaksono, 2017). Bahasa pemrograman arduino adalah menggunakan 

bahasa pemrograman yang umum digunakan untuk membuat perangkat lunak 

yang ditanamkan pada arduino board. Bahasa pemrograman arduino mirip dengan 

bahasa pemrograman C++. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Gambar 2.2 : Blok Diagram Arduino Board. 

https://www.researchgate.net/figure/The-arduino-input-output-board-block-
diagram_fig1_329642153 
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Arduino Development Environment adalah perangkat lunak yang 

digunakan untuk menulis dan meng-compile program untuk arduino. Arduino 

Development Environment juga digunakan untuk meng-upload program yang 

sudah di-compile ke memori program arduino board. Arduino board yang 

menggunakan mikrokontroler ATmega328. Arduino uno memiliki 14 pin digital 

(6 pin dapat digunakan sebagai output PWM), 6 input analog, sebuah 16 MHz 

osilator kristal, sebuah koneksi USB, sebuah konektor sumber tegangan, sebuah 

header ICSP, dan sebuah tombol reset.  

Arduino Uno memuat segala hal yang dibutuhkan untuk mendukung 

sebuah mikrokontroler. Hanya dengan menghubungkannya ke sebuah komputer 

melalui USB atau memberikan tegangan DC dari baterai atau adaptor AC ke DC 

sudah dapat membuatnya bekerja. Arduino uno menggunakan Atmega328 yang 

diprogram sebagai USB-to-serial converter untuk komunikasi serial ke komputer 

melalui port USB. Bentuk fisik dari board arduino adalah seperti yang 

ditunjukkan pada Gambar 2.3 di bawah ini. 

 

 

Gambar 2.3: Board Arduino UnoR3 ATmega328. 

https://www.arduinoindonesia.id/2018/08/arduino-uno-r3.html 
 
 

----------------------------------------------------- 
© Hak Cipta Di Lindungi Undang-Undang 
----------------------------------------------------- 
1. Dilarang Mengutip sebagian atau seluruh dokumen ini tanpa mencantumkan sumber 
2. Pengutipan hanya untuk keperluan pendidikan, penelitian dan penulisan karya ilmiah 
3. Dilarang memperbanyak sebagian atau seluruh karya ini dalam bentuk apapun tanpa izin Universitas Medan Area

Document Accepted 4/8/22 
 
 
 
 

Access From (repository.uma.ac.id)4/8/22 
 
 
 

Access From (repository.uma.ac.id)

UNIVERSITAS MEDAN AREA

Rahmat Timotius Gulo - Rancangan Sistem Kendali Otomatis Pengatur Volume Air

https://www.arduinoindonesia.id/2018/08/arduino-uno-r3.html


9 
 

 
 

Adapun data teknis board arduino uno R3 adalah sebagai berikut: 

1. Mikrokontroler : ATmega328  

2. Tegangan Operasi : 5V  

3. Tegangan Input (recommended) : 7 - 12 V  

4. Tegangan Input (limit) : 6-20 V  

5. Pin digital I/O : 14 (6 diantaranya pin PWM)  

6. Pin Analog input : 6  

7. Arus DC per pin I/O : 40 mA  

8. Arus DC untuk pin 3.3 V : 150 mA  

9. Flash Memory : 32 KB dengan 0.5 KB digunakan untuk bootloader  

10. SRAM : 2 KB 

11. EEPROM : 1 KB  

12. Kecepatan Pewaktuan : 16 Mhz 

 Tujuan awal dibuat Arduino adalah untuk membuat perangkat mudah dan 

murah, dari perangkat yang ada saat itu. Dan perangkat tersebut ditujukan untuk 

para siswa yang akan membuat perangkat desain dan interaksi. Saat ini tim 

pengembangnya adalah Massimo Banzi, David Cuartielles, Tom Igoe, Gianluca 

Martino, David Mellis, dan Nicholas Zambetti. Mereka mengupayakan 4 hal 

dalam Arduino ini, yaitu: 

1. Harga terjangkau 

2. Dapat dijalankan diberbagai sistem operasi, Windows, Linux, Mac, dan 

sebagainya. 

3. Sederhana, dengan bahasa pemrograman yang mudah bisa dipelajari orang 

awam, bukan untuk orang teknik saja. 
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4. Open Source, hardware maupun software. 

 Bahasa “UNO” berasal dari bahasa Italia yang artinya SATU, ditandai 

dengan peluncuran pertama Arduino 1.0, Uno pada versi 1.0 sebagai referensi 

untuk Arduino yang selanjutnya, seri Uno versi terbaru dilengkapi USB.  

2.2.1. Jenis Arduino 

 Seperti Microcontroller yang banyak jenisnya, Arduino lahir dan 

berkembang, kemudian muncul dengan berbagai jenis yaitu : 

a. Arduino Uno 

 Jenis yang ini adalah yang paling banyak digunakan. Terutama untuk 

pemula sangat disarankan untuk menggunakan Arduino Uno. Banyak sekali 

referensi yang membahas Arduino Uno. Versi yang terakhir adalah Arduino Uno 

R3 (Revisi 3), menggunakan ATMEGA328 sebagai Microcontroller-nya, 

memiliki 14 pin I/O digital dan 6 pin input analog. Untuk pemrograman cukup 

menggunakan koneksi USB type A to  type B. Sama seperti yang digunakan pada 

USB printer. 

b. Arduino Due 

 Berbeda dengan saudaranya, Arduino Due tidak menggunakan ATMEGA, 

melainkan dengan chip yang lebih tinggi ARM Cortex CPU. Memiliki 54 I/O pin 

digital dan 12 pin input analog. Untuk pemrogramannya menggunakan Micro 

USB, terdapat pada beberapa handphone. 

c. Arduino Mega 

 Mirip dengan Arduino Uno, sama-sama menggunakan USB type A to B 

untuk pemrogramannya. Tetapi Arduino Mega, menggunakan Chip yang lebih 
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tinggi ATMEGA2560. Dan tentu saja untuk Pin I/O Digital dan pin input 

Analognya lebih banyak dari Uno. 

d. Arduino Leonardo 

 Bisa dibilang Leonardo adalah saudara kembar dari Uno. Dari mulai 

jumlah pin I/O digital dan pin input Analognya sama. Hanya pada Leonardo 

menggunakan Micro USB untuk pemrogramannya. 

e. Arduino Fio 

 Bentuknya lebih unik, terutama untuk socketnya. Walau jumlah pin I/O 

digital dan input analognya sama dengan uno dan leonardo, tapi Fio memiliki 

Socket XBee. XBee membuat Fio dapat dipakai untuk keperluan projek yang 

berhubungan dengan wireless. 

f. Arduino Lilypad 

 Bentuknya yang melingkar membuat Lilypad dapat dipakai untuk 

membuat projek unik. Seperti membuat amor iron man misalkan. Hanya versi 

lamanya menggunakan ATMEGA168, tapi masih cukup untuk membuat satu 

projek keren. Dengan 14 pin I/O digital, dan 6 pin input analognya. 

g. Arduino Nano 

 Seperti namanya, Nano yang berukulan kecil dan sangat sederhana ini, 

menyimpan banyak fasilitas. Sudah dilengkapi dengan FTDI untuk pemrograman 

lewat Micro USB. 14 Pin I/O Digital, dan 8 Pin input Analog (lebih banyak dari 

Uno). Dan ada yang menggunakan ATMEGA168, atau ATMEGA328. 
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h. Arduino Mini 

 Fasilitasnya sama dengan yang dimiliki Nano. Hanya tidak dilengkapi 

dengan Micro USB untuk pemrograman. Dan ukurannya hanya 30 mm x 18 mm 

saja. 

i. Arduino Micro 

 Ukurannya lebih panjang dari Nano dan Mini. Karena memang 

fasilitasnya lebih banyak yaitu; memiliki 20 pin I/O digital dan 12 pin input 

analog. 

j. Arduino Ethernet 

 Ini arduino yang sudah dilengkapi dengan fasilitas ethernet. Membuat 

Arduino kamu dapat berhubungan melalui jaringan LAN pada komputer. Untuk 

fasilitas pada Pin I/O Digital dan Input Analognya sama dengan Uno. 

k. Arduino Esplora 

 Rekomendasi bagi kamu yang mau membuat gadget sepeti Smartphone, 

karena sudah dilengkapi dengan Joystick, button, dan sebagainya. Kamu hanya 

perlu tambahkan LCD, untuk lebih mempercantik Esplora. 

l. Arduino Robot 

 Ini adalah paket komplit dari Arduino yang sudah berbentuk robot. Sudah 

dilengkapi dengan LCD, Speaker, Roda, Sensor Infrared, dan semua yang kamu 

butuhkan untuk robot sudah ada pada Arduino ini. 

2.2.2. Pin Masukan dan Keluaran Arduino Uno  

Masing-masing dari 14 pin digital arduino uno dapat digunakan sebagai 

masukan atau keluaran menggunakan fungsi pinMode(), digitalWrite() dan 

digitalRead(). Setiap pin beroperasi pada tegangan 5 volt. Setiap pin mampu 
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menerima atau menghasilkan arus maksimum sebasar 40 mA dan memiliki 

resistor pull-up internal (diputus secara default) sebesar 20-30 KOhm. Sebagai 

tambahan, beberapa pin masukan digital memiliki kegunaan khusus yaitu: 

1. Komunikasi serial: pin 0 (RX) dan pin 1 (TX), digunakan untuk 

menerima(RX) dan mengirim(TX) data secara serial.  

2. External Interrupt: pin 2 dan pin 3, pin ini dapat dikonfigurasi untuk 

memicu sebuah interrupt pada nilai rendah, sisi naik atau turun, atau pada 

saat terjadi perubahan nilai.  

3. Pulse-width modulation (PWM): pin 3,5,6,9,10 dan 11, menyediakan 

keluaran PWM 8-bit dangan menggunakan fungsi analogWrite().  

4. Serial Peripheral Interface (SPI): pin 10 (SS), 11 (MOSI), 12 (MISO) dan 

13 (SCK), pin ini mendukung komunikasi SPI dengan menggunakan SPI 

library.  

5. LED: pin 13, terdapat built-in LED yang terhubung ke pin digital 13. 

Ketika pin bernilai HIGH maka LED menyala, sebaliknya ketika pin 

bernilai LOW maka LED akan padam.  

Arduino Uno memiliki 6 masukan analog yang diberi label A0 sampai A5, 

setiap pin menyediakan resolusi sebanyak 10 bit (1024 nilai yang berbeda). Secara 

default pin mengukur nilai tegangan dari ground (0V) hingga 5V, walaupun 

begitu dimungkinkan untuk mengganti nilai batas atas dengan menggunakan pin 

AREF dan fungsi analogReference(). Sebagai tambahan beberapa pin masukan 

analog memiliki fungsi khusus yaitu pin A4 (SDA) dan pin A5 (SCL) yang 

digunakan untuk komunikasi Two Wire Interface (TWI) atau Inter Integrated 

Circuit (I2C) dengan menggunakan Wire library 
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2.2.3. Sumber Daya dan Pin Tegangan Arduino Uno  

Arduino uno dapat diberi daya melalui koneksi USB (Universal Serial 

Bus) atau melalui power supply eksternal. Jika arduino uno dihubungkan ke kedua 

sumber daya tersebut secara bersamaan maka arduino uno akan memilih salah 

satu sumber daya secara otomatis untuk digunakan. Power supplay external (yang 

bukan melalui USB) dapat berasal dari adaptor AC ke DC atau baterai. Adaptor 

dapat di hubungkan ke soket power pada arduino uno. Jika menggunakan baterai, 

ujung kabel yang dibubungkan ke baterai dimasukkan kedalam pin GND dan Vin 

yang berada pada konektor Power. Arduino uno dapat beroperasi pada tegangan 6 

sampai 20 Volt. Jika arduino uno di beri tegangan di bawah 7 Volt, maka pin 5V 

akan menyediakan tegangan di bawah 5 Volt dan arduino uno munkin bekerja 

tidak stabil. Jika diberikan tegangan melebihi 12 Volt, penstabil tegangan 

kemungkinan akan menjadi terlalu panas dan merusak arduino uno. Tegangan 

rekomendasi yang diberikan ke arduino uno berkisar antara 7 sampai 12 Volt. 

Pin-pin tegangan pada arduino uno adalah sebagai berikut: 

1. Vin adalah pin untuk mengalirkan sumber tegangan ke arduino uno ketika 

menggunakan sumber daya eksternal (selain dari koneksi USB atau 

sumber daya yang teregulasi lainnya). Sumber tegangan juga dapat 

disediakan melalui pin ini jika sumber daya yang digunakan untuk arduino 

uno dialirkan melalui soket power.  

2. 5V adalah pin yang menyediakan tegangan teregulasi sebesar 5 Volt 

berasal dari regulator tegangan pada arduino uno. 

3. 3V3 adalah pin yang meyediakan tegangan teregulasi sebesar 3,3 Volt 

berasal dari regulator tegangan pada arduino uno.  
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4. GND adalah pin ground.  

2.2.4. Peta Memori Arduino Uno  

Arduino Uno adalah arduino board yang menggunakan mikrokontroler 

ATmega328. Maka peta memori arduino uno sama dengan peta memori pada 

mikrokontroler ATmega328. (Kadir, 2016) 

2.2.4.1. Memori Program  

 
ATMega328 memiliki 32K byte On-chip In-System Reprogrammable 

Flash Memory untuk menyimpan program. Memori flash dibagi ke dalam dua 

bagian, yaitu bagian program bootloader dan aplikasi seperti terlihat pada Gambar 

2.4. Bootloader adalah program kecil yang bekerja pada saat sistem dimulai yang 

dapat memasukkan seluruh program aplikasi ke dalam memori prosesor. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Gambar 2.4 : Peta Memori Program Atmega 328. 

https://www.webstudi.site/2017/05/mikrokontroler-atmega8535.html 

 

2.2.4.2. Memori Data  

 
Memori data ATMega328 terbagi menjadi 4 bagian, yaitu 32 lokasi untuk 

register umum, 64 lokasi untuk register I/O, 160 lokasi untuk register I/O 

tambahan dan sisanya 2048 lokasi untuk data SRAM internal. Register umum 
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menempati alamat data terbawah, yaitu 0x0000 sampai 0x001F. Register I/O 

menempati 64 alamat berikutnya mulai dari 0x0020 hingga 0x005F. Register I/O 

tambahan menempati 160 alamat berikutnya mulai dari 0x0060 hingga 0x00FF. 

Sisa alamat berikutnya mulai dari 0x0100 hingga 0x08FF digunakan untuk SRAM 

internal. Peta memori data dari ATMega 328 dapat dilihat pada Gambar 2.5. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Gambar 2.5 : Peta Memori Data Atmega 328. 

http://eprints.polsri.ac.id/3269/3/File%20III.pdf 
 

2.2.4.3. Memori Data EEPROM  

 
Arduino uno terdiri dari 1 KByte memori data EEPROM. Pada memori 

EEPROM, data dapat ditulis/dibaca kembali dan ketika catu daya dimatikan, data 

terakhir yang ditulis pada memori EEPROM masih tersimpan pada memori ini, 

atau dengan kata lain memori EEPROM bersifat nonvolatile. Alamat EEPROM 

dimulai dari 0x000 hingga 0x3FF. 
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2.3. Bahasa Pemrograman Arduino 

Arduino board merupakan perangkat yang berbasiskan mikrokontroler. 

Perangkat lunak (software) merupakan komponen yang membuat sebuah 

mikrokontroller dapat bekerja. Arduino board akan bekerja sesuai dengan perintah 

yang ada dalam perangkat lunak yang ditanamkan padanya. Bahasa Pemrograman 

Arduino adalah bahasa pemrograman utama yang digunakan untuk membuat 

program untuk arduino board. Bahasa pemrograman arduino menggunakan 

bahasa pemrograman C sebagai dasarnya. (Effendi, 2014). Karena menggunakan 

bahasa pemrograman C sebagai dasarnya, bahasa pemrograman arduino memiliki 

banyak sekali kemiripan, walaupun beberapa hal telah berubah.  

 
2.4. Struktur  

Setiap program dalam arduino board terdiri dari dua fungsi utama yaitu 

setup() dan loop(). Instruksi yang berada dalam fungsi setup() dieksekusi hanya 

sekali, yaitu ketika arduino board pertama kali dihidupkan. Biasanya instruksi 

yang berada pada fungsi setup() merupakan konfigurasi dan inisialisasi dari 

arduino board. Instruksi yang berada pada fungsi loop() dieksekusi berulang-ulang 

hingga arduino board dimatikan (catu daya diputus). Fungsi loop() merupakan 

tugas utama dari arduino board. Jadi setiap program yang menggunakan bahasa 

pemrograman arduino memilliki struktur sebagai berikut: 

void setup () 

{ 

  // perintah-perintah untuk konfigurasi dan inisialisasi arduino board 

  

} 

 

void loop () 

{ 

  // perintah-perintah utama arduino board 

} 
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Program diatas dapat dianalogikan dalam bahasa C sebagai berikut: 
 
void setup (void); // prototipe fungsi setup 

void loop (void); // prototipe fungsi loop 

int main (void) { 

setup(); // 

while(1) { 

loop (); // ulangi terus menerus 

} 

return 0; //bagian ini tidak pernah dieksekusi 

} 
 
 

2.5. Konstanta  

Konstanta adalah variable yang sudah ditetapkan sebelumnya dalam 

bahasa pemrograman arduino. Konstanta digunakan agar program lebih mudah 

untuk dibaca dan dimengerti. Konstanta dibagi menjadi 3 kelompok yaitu: 

1.  Konstanta yang digunakan untuk menunjukkan tingkat logika (konstanta 

Boolean), yaitu true dan false 

2. Konstanta untuk menunjukkan keadaan pin, yaitu HIGH dan LOW  

3. Konstanta untuk menunjukkan fungsi pin, yaitu INPUT, INPUT_PULLUP 

dan OUTPUT 

Konstanta yang digunakan untuk menunjukkan benar atau salah dalam 

bahasa pemrograman arduino adalah true dan false. False lebih mudah 

didefinisikan dari pada true. False didefinisikan sebagai 0 (nol). True sering 

didefinisikan sebagai 1 (satu), yang mana hal ini benar, tetapi true memiliki 

definisi yang lebih luas. Setiap integer yang bukan nol adalah true dalam 

pengertian Boolean. Jadi -2, 3 dan -100 semuanya didefinisikan sebagai true, juga 

dalam pengertian Boolean. Tidak seperti konstanta yang lain true dan false diketik 

dengan menggunakan huruf kecil. 
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Ketika membaca atau menulis ke sebuah pin digital, terdapat hanya dua 

nilai yang dapat diberikan atau diterima, yaitu HIGH dan LOW. HIGH memiliki 

arti yang berbeda tergantung apakah sebuah pin dikonfigurasi menjadi masukan 

atau keluaran. Ketika pin dikonfigurasi sebagai masukan dengan fungsi 

pinMode(), lalu kemudian dibaca dengan fungsi digitalRead(), mikrokontroler 

akan melaporkan nilai HIGH jika tegangan yang ada pada pin tersebut berada 

pada tegangan 3 volt atau lebih. 

Ketika sebuah pin dikonfigurasi sebagai masukan, dan kemudian dibuat 

bernilai HIGH dengan fungsi digitalWrite(), maka resistor pull-up internal dari 

chip ATmega akan aktif, yang akan membawa pin masukan ke nilai HIGH 

kecuali pin tersebut ditarik (pull-down) ke nilai LOW oleh sirkuit dari luar. 

Ketika pin dikonfigurasi sebagai keluaran dengan fungsi pinMode(), dan 

diset ke nilai HIGH dengan fungsi digitalWrite(), maka pin berada pada tegangan 

5 volt. Dalam keadaan ini, pin tersebut dapat memberikan arus, sebagai contoh, 

untuk menghidupkan LED yang terhubung seri dengan resistor dan ground, atau 

pin lain yang dikonfigurasi sebagai keluaran dan diberi nilai LOW. 

Sama seperti HIGH, LOW juga memiliki arti yang berbeda bergantung 

pada konfigurasi pin. Ketika pin dikonfigurasi sebagai masukan, maka 

mikrokontroler akam melaporkan nilai LOW jika tegangan yang terdapat pada pin 

berada pada tegangan 2 volt atau kurang. Ketika pin dikonfigurasi sebagai 

keluaran dan diberi nilai LOW maka pin berada pada tegangan 0 volt. 
 

Setiap pin pada arduino dapat dikonfigurasi sebagai masukan, masukan 

dengan resistor pull-up atau keluaran. Untuk mengkonfigurasi fungsi pin pada 

arduino digunakan konstanta INPUT, INPUT_PULLUP dan OUTPUT. Pin 
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arduino yang dikonfigurasi sebagai masukan dengan fungsi pinMode() dikatakan 

berada dalam kondisi berimpedansi tinggi. Pin yang dikonfigurasi sebagai 

masukan memiliki permintaan yang sangat kecil kepada sirkuit yang di-sampling-

nya, setara dengan sebuah resistor 100 Mega ohm dipasang seri dengan pin 

tersebut. Hal ini membuat pin tersebut berguna untuk membaca sensor, tetapi 

tidak untuk menghidupkan sebuah LED.  

Cip ATmega pada arduino memiliki resisitor pull-up internal (resistor 

yang terhubung ke sumber tegangan secara internal) yang dapat digunakan. Untuk 

menggunakan resistor pull-up internal ini kita menggunakan konstatnta 

INPUT_PULLUP pada fungsi pinMode(). Pin yang dikonfigurasi menjadi sebuah 

keluaran dikatakan berada dalam kondisi berimpedansi rendah. Hal ini berarti pin 

tersebut dapat menyediakan sejumlah besar arus ke sirkuit yang lain. Pin pada 

ATmega mampu menyediakan arus hingga 40 mA. 

2.6. Fungsi Masukan dan Keluaran Digital 

Arduino memiliki 3 fungsi untuk masukan dan keluaran digital pada 

arduino board, yaitu pinMode(), digitalWrite() dan digitalRead().  

Fungsi pinMode() mengkonfigurasi pin tertentu untuk berfungsi sebagai 

masukan atau keluaran. Sintaksis untuk fungsi pinMode() adalah sebagai berikut: 

pinMode(pin, mode) 

Parameter: pin = angka dari pin digital yang akan dikonfigurasi 

mode = konfigurasi yang diinginkan (INPUT,  INPUT_PULLUP dan OUTPUT). 

Fungsi digitalWrite() berfungsi untuk memberikan nilai HIGH atau 

LOWsuatu digital pin. Sintaksis untuk fungsi digitalWrite() adalah sebagai 

berikut: 
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digitalWrite(pin, value) 

Parameter: pin = angka dari pin digital yang akan dikonfigurasi value = nilai 

yang diinginkan (HIGH atau LOW). 

Fungsi digitalRead () bertujuan untuk membaca nilai yang ada pada pin 

arduino uno. Sintaksis untuk fungsi digitalRead () adalah sebagai berikut: 

digitalRead(pin) 

Parameter: pin = angka dari pin digital yang akan dibaca 

 

Berikut ini adalah contoh penggunaan fungsi masukan dan keluaran digital 

dalam sebuah program: 
 
int ledPin = 13; // LED terhubung ke pin digital 13  
Int inPin = 7; // pushbutton terhubung ke pin digital 7 

Int val = 0; // variable untuk menyimpan sebuah nilai 
 
void setup()  

 

{ 
// set pin digital 13 sebagai keluaran 

 

pinMode(ledPin, OUTPUT); 
 

pinMode(inPin, INPUT); // set pin digital 13 sebagai masukan 
 

}  
 

void loop()  
 

{ 
// baca nilai pin input 

 

val = digitalRead(inPin); 
 

digitalWrite(ledPin, val); // sets LED sesuai dengan nilai val  
} 

 

2.7. Arduino IDE 

Arduino IDE merupakan kependekan dari Integrated Development 

Environment yang merupakan software untuk melakukan penulisan program, 

compile serta upload program ke board arduino.  

Integrated Development Environment terdiri dari editor teks untuk menulis  

kode, sebuah area pesan, sebuah konsol, sebuah toolbar dengan tombol-tombol 

untuk fungsi yang umum dan beberapa menu. Arduino Development Environment 
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terhubung ke arduino board untuk meng-upload program dan juga untuk 

berkomunikasi dengan arduino board. 

Perangkat lunak yang ditulis menggunakan Arduino Development 

Environment disebut sketch. Sketch ditulis pada editor teks. Sketch disimpan 

dengan file berekstensi.ino. Area pesan memberikan memberikan informasi dan 

pesan error ketika kita menyimpan atau membuka sketch. Konsol menampilkan 

output teks dari Arduino Development Environment dan juga menampilkan pesan 

error ketika kita mengkompile sketch. Pada sudut kanan bawah dari jendela 

Arduino Development Environment menunjukkan jenis board dan port serial yang 

sedang digunakan. Tombol toolbar digunakan utuk mengecek dan mengupload 

sketch, membuat, membuka atau menyimpan sketch, dan menampilkan serial 

monitor. 

 
 

Gambar 2.6 : Arduino Integrated Development Environment. 
https://mikrokontroler.mipa.ugm.ac.id/2018/10/02/penggunaan-arduino-ide/ 
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Berikut ini adalah tombol-tombol toolbar serta fungsinya: 
 

Verify  
mengecek error pada code program. 

 
Upload  
meng-compile dan meng-upload program ke Arduino board. 

 
New  
membuat sketch baru. 

 
Open 

menampilkan sebuah menu dari seluruh sketch yang berada didalam 
sketchbook.  
Save  
menyimpan sketch. 

 
Serial Monitor  

membuka serial monitor. 

 

Dalam lingkungan arduino digunakan sebuah konsep yang disebut 

sketchbook, yaitu tempat standar untuk menumpang program (sketch). Sketch 

yang ada pada sketchbook dapat dibuka dari menu File > Sketchbook atau dari 

tombol open pada toolbar. Ketika pertama kali menjalankan arduino development 

environment, sebuah direktori akan dibuat secara otomatis untuk tempat 

penyimpana sketchbook. Kita dapat melihat atau mengganti lokasi dari direktori 

tersebut dari menu File > Preferences. 
 

Serial monitor menampilkan data serial yang sedang dikirim dari arduino 

board. Untuk mengirim data ke board, masukkan teks dan klik tombol send atau 

tekan enter pada keyboard. 

Sebelum meng-upload program, kita perlu mensetting jenis board dan port 

serial yang sedang kita gunakan melalui menu Tools > Board dan Tools > 

SerialPort. Pemilihan board berguna untuk mengeset parameter (contohnya: 
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kecepatan mikrokontroler dan baud rate) yang digunakan ketika meng-compile 

dan meng-upload sketch. 

Setelah memilih board dan port serial yang tepat, tekan tombol upload 

pada toolbar atau pilih menu File > Upload. Arduino board akan me-reset secara 

otomatis dan proses upload akan dimulai. Pada kebanyakan board, LED RX dan 

TX akan berkedip ketika program sedang di-upload. Arduino development 

environment akan menampilkan pesan ketika proses upload telah selesai, atau 

menampilkan pesan error. 
 

Ketika sedang meng-upload program, arduino bootloader sedang 

digunakan, Arduinp bootloader adalah sebuah program kecil yang telah 

ditanamkan pada mikrokontroler yang berada pada arduino board. Bootloader ini 

mengijinkan kita meng-upload program tanpa menggunakan perangkat keras 

tambahan. 

2.8. Sensor 

 Sensor adalah perangkat yang digunakan untuk mendeteksi perubahan 

besaran fisik seperti tekanan, gaya, besaran listrik, cahaya, gerakan, kelembaban, 

suhu, kecepatan dan fenomena-fenomena lingkungan lainnya. Setelah mengamati 

terjadinya perubahan, Input yang terdeteksi tersebut akan dikonversi mejadi 

output yang dapat dimengerti oleh manusia baik melalui perangkat sensor itu 

sendiri ataupun ditransmisikan secara elektronik melalui jaringan untuk 

ditampilkan atau diolah menjadi informasi yang bermanfaat bagi penggunanya. 

(Dickson Kho, 2021) 

 Sensor pada dasarnya dapat digolongkan sebagai Transduser Input karena 

dapat mengubah energi fisik seperti cahaya, tekanan, gerakan, suhu atau energi 
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fisik lainnya menjadi sinyal listrik ataupun resistansi (yang kemudian 

dikonversikan lagi ke tegangan atau sinyal listrik). 

 Sensor-sensor yang digunakan pada perangkat elektronik pada dasarnya 

dapat diklasifikasikan menjadi dua kategori utama yaitu : 

1. Sensor Pasif dan Sensor Aktif 

2. Sensor Analog dan Sensor Digital 

Berikut ini adalah pembahasan singkat mengenai kedua klasifikasi sensor 

tersebut. 

2.8. 1. Sensor Pasif dan Sensor Aktif 

2.8.1.1.  Sensor Pasif (Passive Sensor) 

 Sensor Pasif adalah jenis sensor yang dapat menghasilkan sinyal output 

tanpa memerlukan pasokan listrik dari eksternal. Contohnya Termokopel 

(Thermocouple) yang menghasilkan nilai tegangan sesuai dengan panas atau suhu 

yang diterimanya. 

2.8.1.2. Sensor Aktif (Active Sensor) 

 Sensor Aktif adalah jenis sensor yang membutuhkan sumber daya 

eskternal untuk dapat beroperasi. Sifat fisik Sensor Aktif bervariasi sehubungan 

dengan efek eksternal yang diberikannya. Sensor Aktif ini disebut juga dengan 

Sensor Pembangkit Otomatis (Self Generating Sensors). 

 
2.8.2. Sensor Analog dan Sensor Digital 

 Berikut ini adalah jenis-jenis sensor berdasarkan sifat Analog atau 

Digitalnya. 
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2.8.2.1.Sensor Analog 

 Sensor Analog adalah sensor yang menghasilkan sinyal output yang 

kontineu atau berkelanjutan.  Sinyal keluaran kontineu yang dihasilkan oleh 

sensor analog ini sebanding dengan pengukuran. Berbagai parameter Analog ini 

diantaranya adalah suhu, tegangan, tekanan, pergerakan dan lain-lainnya. Contoh 

Sensor Analog ini diantaranya adalah akselerometer (accelerometer), sensor 

kecepatan, sensor tekanan, sensor cahaya dan sensor suhu. 

2.8.2.2.Sensor Digital 

 Sensor Digital adalah sensor yang menghasilkan sinyal keluaran diskrit. 

Sinyal diskrit akan non-kontineu dengan waktu dan dapat direpresentasikan dalam 

“bit”. Sebuah sensor digital biasanya terdiri dari sensor, kabel dan pemancar. 

Sinyal yang diukur akan diwakili dalam format digital. Output digital dapat dalam 

bentuk Logika 1 atau logika 0 (ON atau OFF). Sinyal fisik yang diterimanya akan 

dikonversi menjadi sinyal digital di dalam sensor itu sendiri tanpa komponen 

eksternal. Kabel digunakan untuk transmisi jarak jauh. Contoh Sensor Digital ini 

diantaranya adalah akselerometer digital (digital accelerometer), sensor kecepatan 

digital, sensor tekanan digital, sensor cahaya digital dan sensor suhu digital. 

2.9. Sensor Ultrasonik HC-SR04 

Sensor ultrasonik HC-SR04 adalah sensor pengukur jarak berbasis 

gelombang ultrasonik. Keunggulan sensor ini adalah jangkauan deteksi sekitar 2 

cm sampai kisaran 400-500 cm dengan resolusi 1 cm. Sensor HCSR04 adalah 

versi low cost dari sensor ultrasonic PING buatan parallax. Perbedaaannya 

terletak pada pin yang digunakan. HCSR04 menggunakan 4 pin sedangkan PING 

buatanParallax menggunakan 3 pin. 
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 Sensor ultrasonik tipe HC-SR04 merupakan perangkat yang digunakan 

untuk mengukur jarak dari suatu objek. Kisaran jarak yang dapat diukur sekitar 2-

450 cm. Perangkat ini menggunakan dua pin digital untuk mengkomunikasikan 

jarak yang terbaca. Prinsip kerja sensor ultrasonik ini bekerja dengan 

mengirimkan pulsa ultrasonik sekitar 40 KHz, kemudian dapat memantulkan 

pulsa echo kembali, dan menghitung waktu yang diambil dalam mikrodetik 

sebagaimana digambarkan dalam Gambar 2.8. Kita dapat memicu pulsa secepat 

20 kali per detik dan itu bisa tentukan objek hingga 3 meter. (A. Soni, 2018) 

 

 
Gambar 2.7: Sensor Ultrasonik HC-SR04. 

https://www.andalanelektro.id/2018/09/cara-kerja-dan-karakteristik-sensor-ultrasonic-hcsr04.html 
 

Fungsi pin-pin sensor ultrasonik HC-SR04 : 

1. VCC =  5V Power Supply. Pin sumber tegangan positif sensor. 

2. Trig =  Trigger/Penyulut. Pin ini yang digunakan untuk membangkitkan 

sinyal ultrasonik. 

3. Echo =  Receive/Indikator. Pin ini yang digunakan untuk mendeteksi 

sinyal pantulan ultrasonik. 

4. GND =  Ground/0V Power Supply. Pin sumber tegangan negatif sensor. 
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 HC-SR04 memiliki 2 komponen utama sebagai penyusunnya 

yaitu ultrasonic transmitter dan ultrasonic receiver.Fungsi dari ultrasonic 

transmitter adalah memancarkan gelombang ultrasonik dengan frekuensi 40 KHz 

kemudian ultrasonic receiver menangkap hasil pantulan gelombang ultrasonik 

yang mengenai suatu objek.  

 
Waktu tempuh gelombang ultrasonik dari pemancar hingga sampai ke 

penerima sebanding dengan 2 kali jarak antara sensor dan bidang pantul seperti 

yang diperlihatkan pada Gambar 2.8 dibawah ini : 

 

 

Gambar 2.8:  

Bentuk Pemancaran Dan Penerimaan Gelombang Sensor Ultrasonik HC-SR04. 

https://www.andalanelektro.id/2018/09/cara-kerja-dan-karakteristik-sensor-ultrasonic-hcsr04.html 
 

 2.9.1. Cara Kerja Sensor HC SR04 

 Prinsip pengukuran jarak menggunakan sensor ultrasonik HC-SR04 

adalah, ketika pulsa trigger diberikan pada sensor, transmitter akan mulai 

memancarkan gelombang  ultrasonik, pada saat yang sama sensor akan 

menghasilkan output TTL transisi naik menandakan sensor mulai menghitung 

waktu pengukuran, setelah receiver menerima  pantulan yang dihasilkan oleh 

suatu objek maka pengukuran waktu akan dihentikan dengan menghasilkan output 
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TTL transisi turun. Jika waktu pengukuran adalah t dan kecepatan suara adalah 

340 m/s, maka jarak antara sensor dengan objek dapat dihitung dengan 

menggunakan persamaan di bawah ini : 

 

      
      

 
 

Dimana : 
 

s = Jarak sensor dengan objek (m) 
t = Waktu tempuh gelombang ultrasonik dari transmiter ke receiver (s) 
 

 

Gambar 2.9 : Deskripsi Sistem Kerja Sensor Ultrasonik Dengan Bentuk Persaman. 

https://mikroavr.com/sensor-jarak-ultrasonik-arduino/ 
 
 

 Pemilihan HC-SR04 sebagai sensor jarak yang akan digunakan pada 

penelitian ini karena memiliki fitur sebagai berikut; kinerja yang stabil, 

pengukuran jarak yang akurat dengan ketelitian 0,3 cm, pengukuran maksimum 

dapat mencapai 4 meter dengan jarak minimum 2 cm, ukuran yang ringkas dan 

dapat beroperasi pada level tegangan TTL Prinsip pengoperasian sensor ultrasonik 

HC-SR04 adalah dengan mengawali memberikan pulsa Low (0) ketika modul 

mulai dioperasikan, kemudian berikan pulsa High (1) pada trigger selama 10 μs 

sehingga modul mulai memancarkan 8 gelombang kotak dengan frekuensi 40 

KHz, tunggu hingga transisi naik terjadi pada output dan mulai perhitungan waktu 

hingga transisi turun terjadi, setelah itu gunakan Persamaan 2.1 untuk mengukur 
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jarak antara sensor dengan objek. Timing diagram pengoperasian sensor 

ultrasonik HC-SR04 diperlihatkan pada Gambar berikut : 

 

 

Gambar 2.10: Timing diagram pengoperasian sensor ultrasonik HC-SR04 

https://dennydarlis.staff.telkomuniversity.ac.id/empat-point-nol/limapointdua/4-2-2-sensor/4-2-2-
2-modul-ultrasonik-hcsr04/ 

 

 

Dari Gambar 2.10 diatas dijelaskan bahwa  

1. Kita perlu mengirimkan pulsa pemicu paling sedikit 10 us ke pin Trig HC-

SR04. 

2. Kemudian secara otomatis HC-SR04 mengirimkan delapan gelombang 

suara 40 kHz dan menunggu keluaran sisi naik di pin Echo. 

3. Apabila pengambilan sisi naik muncul di pin Echo, kita mulai Timer dan 

menunggu sisi turun di pin Echo. 

4. Begitu sisi turun diambil dari pin Echo, kita baca hitungan Timer. 

Perhitungan waktu ini merupakan waktu yang dibutuhkan sensor untuk 

mendeteksi sebuah obyek dan kembali dari obyek tersebut.Selanjutnya 

cara menghitung jaraknya adalah : 
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Kita ketahui bahwa, 

Jarak = Kecepatan x Waktu 

Kecepatan gelombang suara adalah 340 m/s. 

Sehingga : Jarak Total = (340 x Waktu Pulsa Tinggi (Echo)) / 2 

Jarak totalnya dibagi 2 karena sinyalnya merambat dari HC-SR04 ke obyek dan 

kembali lagi ke modul HC-SR04. 

2.10. LED 

LED singkatan dari (Light Emitting Diode atau Light Emitting Device) 

banyak digunakan sebagai indikator berlangsungnya proses, awal proses atau 

berakhirnya proses pada sistem mikrokontroler, sehingga pengguna dapat 

mengetahui proses yang sedang terjadi. LED memiliki polaritas plus dan minus, 

biasanya posisi plus tegangan ditandai dengan kaki yang lebih panjang dari yang 

lainnya.( Dodit, 2019)  

Bentuk fisik LED ditunjukkan seperti tampak pada Gambar 2.11 di bawah 

ini. 

 

Gambar 2.11: Bentuk Fisik LED Dengan Jenis Warna. 

https://www.pcboard.ca/3mm-frosted-lens-led 
 

----------------------------------------------------- 
© Hak Cipta Di Lindungi Undang-Undang 
----------------------------------------------------- 
1. Dilarang Mengutip sebagian atau seluruh dokumen ini tanpa mencantumkan sumber 
2. Pengutipan hanya untuk keperluan pendidikan, penelitian dan penulisan karya ilmiah 
3. Dilarang memperbanyak sebagian atau seluruh karya ini dalam bentuk apapun tanpa izin Universitas Medan Area

Document Accepted 4/8/22 
 
 
 
 

Access From (repository.uma.ac.id)4/8/22 
 
 
 

Access From (repository.uma.ac.id)

UNIVERSITAS MEDAN AREA

Rahmat Timotius Gulo - Rancangan Sistem Kendali Otomatis Pengatur Volume Air

https://www.pcboard.ca/3mm-frosted-lens-led


32 
 

 
 

2.11. LCD 2x16 (Liquid Crystal Display) 

 LCD merupakan sebuah modul yang berfungsi untuk menampilkan suatu 

karakter huruf dan angka, sehingga dapat dilihat dan ketahui melalui tampilan 

layar kristalnya. (Setiyo, 2012) 

 Berikut ini adalah Gambar 2.12 yang menampilkan bentuk fisik LCD 2 x 

16 : 

 

 
 

Gambar 2.12 : Bentuk Fisik LCD 16x2. 

http://www.leselektronika.com/2012/06/liguid-crystal-display-lcd-16-x-2.html 
 

LCD sebagai penampil dengan sistem termodul, yang dapat menampilkan 

baik karakter, angka atau pun simbol yang tentunya lebih bagus daripada seven 

segment. Bentuk dan ukuran beragam, salah satu variasi bentuk dan ukuran yang 

tersedia dan umum digunakan adalah 16x2 karakter (panjang 16, baris 2, karakter 

32) dan 16 pin, yaitu delapan jalur hubungan data, tiga jalur hubungan kontrol, 

tiga jalur catu daya dan pada modul LCD dengan fasilitas backlighting terdapat 

dua jalur catu untuk back lighting sehingga mereka dapatditampilkan dalam 

kondisi cahaya yang kecil. Berikut Tabel 2.1 adalah keterangan dari pinLCD: 
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Tabel 2.1 :  Keterangan pin LCD (Ardi Winoto, 2010: 194) 

 
Pin Simbol Kemungkinan Fungsi 

 
     

1 Vss - Power Supply (GND) 
 

     

2 Vdd/Vcc - Power Supply (+5 V) 
 

     

3 Vee/Vo - Contrast Adjust 
 

     

4 RS 0/1 0 = Intruction Input / 1 =Data Input 
 

     

5 R/W 0/1 0 = Write to LCD Module /1 = Read 
 

From LCD Module  

   
 

6 E 1, 1-->0 Enable Signal 
 

     

7 DB0 0/1 Data Pin 0 
 

     

8 DB1 0/1 Data Pin 1 
 

     

9 DB2 0/1 Data Pin 2 
 

     

10 DB3 0/1 Data Pin 3 
 

     

11 DB4 0/1 Data Pin 4 
 

     

12 DB5 0/1 Data Pin 5 
 

     

13 DB6 0/1 Data Pin 6 
 

     

14 DB7 0/1 Data Pin 7 
 

     

15 VB+ - Back Light (+5 V) 
 

     

16 VB- - Back Light (GND) 
 

     

 

2.12. Modul Relay 

 Modul Relay adalah salah satu piranti yang beroperasi berdasarkan prinsip 

elektromagnetik untuk menggerakkan kontaktor guna memindahkan posisi ON ke 

OFF atau sebaliknya dengan memanfaatkan tenaga listrik. Peristiwa tertutup dan 

terbukanya kontaktor ini terjadi akibat adanya efek induksi magnet yang timbul 

dari kumparan induksi listrik. (Aldy Razor, 2020) 

 Susunan sederhana module relay terdiri dari kumparan kawat penghantar 

yang dililitkan pada inti besi. Jika kumparannya dialiri energi listrik, medan 

magnet yang terbentuk menarik armatur berporos yang digunakan sebagai 

pengungkit mekanisme saklar.Modul relay ini juga dapat digunakan sebagai 

switch untuk mengaktifkan berbagai peralatan elektronik. Sebagai fungsi kendali 
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ON atau OFF switch (relay), sepenuhnya ditentukan oleh nilai output sensor, yang 

setelah diproses Mikrokontroler akan menghasilkan perintah kepada 

relay untuk melakukan fungsi ON atau OFF. Berikut Gambar 2.13 yang 

menunjukan bentuk fisik dari modul relay. 

 

 

Gambar 2.13: Bentuk Fisik Modul Relay. 

https://www.indiamart.com/proddetail/single-channel-relay-module-22370743333.html 
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BAB III 

METODOLOGI PENELITIAN 

 

3.1. Tempat Penelitian 

 

 Pembuatan dan pengujian sistem kendali otomatis pengatur volume air 

pada botol sistem irigasi tetes tanaman cabai berbasis arduinoini dilakukan di : 

- Nama Tempat : CV. ANGKASA MOBIE TECH 

- Alamat : Jalan Sultan Serdang Dusun II, Sena, Batang Kuis - 

 Deli Serdang – Sumatera Utara. 

3.2. Waktu Penelitian 

 Waktu yang dibutuhkan pada penelitian ini adalah selama ± 3 bulan, 

sebagaimana yang ditunjukkan pada Tabel 3.1 berikut ini: 

 

Tabel 3.1: Jadwal pelaksanaan penelitian 

No Bentuk Kegiatan 

Bulan Ke 

I II III 

1 2 3 4 1 2 3 4 1 2 3 4 

1 Persiapan Alat dan Bahan             

2 Perancangan Alat Penelitian             

3 Pembuatan Alat (Hardware)             

4 Pembuatan Coding              

5 Pengujian             

6 Penulisan Laporan Skripsi             
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3.3. Metode Penelitian 

 
 

 

Gambar 3.1: Flowchart Kerangka Berfikir Penelitian. 
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Hardware dan Software 
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Membuat Alat Penelitian 

Pengujian Alat Penelitian 

Berhasil 

Penyusunan Laporan Penelitian 

Selesai 

Pengecekan dan Perbaikan 
Alat 

Ya  

Tidak  

Pembuatan dan Koreksi Coding 
Arduino 
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Pelaksanaan penelitian ini di lakukan dalam beberapa tahap untuk 

mempermudah dan memperjelas arah penelitian. Adapun flowchart kerangka 

berfikir dalam penelitian yang disajikan dalam bentuk blok diagram pada Gambar 

3.1 di atas dimana berdasarkan flowchart inilah sebagai tahapan yang akan 

dilakukan oleh peniliti dalam melaksanakan proses penelitian dengan judul 

rancangan sistem kendali otomatis pengatur volume air pada botol sistem irigasi 

tetes tanaman cabai berbasis Arduino. 

3.2.1. Alat dan Bahan 

 Adapun alat yang digunakan pada perancangan ataupun desain rangkaian 

alat pada penelitian ini berupa kertas, pensil, dan sejumlah gambar konfigurasi pin 

dari setiap komponen-komponen elektrikal yang terlibat pada pembuatan 

rangkaian alat. Selanjutnya adapun alat yang digunakan untuk pembuatan sistem 

secara keseluruhan adalah satu set tools mechanic yakni berupa gerinda, bor 

listrik, solder listrik, gergaji pipa,  martil dan mistar. Kemudian alat yang 

digunakan pada uji kinerja alat rancangan antara lain multimeter dan testpen. 

Terakhir adalah alat untuk melakukan pembuatan program atau coding yakni 

meggunakan laptop atau komputer dan sejumlah perangkat downloader program 

ke arduino sebagai komponen pendukung.   

 Sementara bahan yang bersifat material maupun elektrikal yang digunakan 

dalam pembuatan sistem ini adalah seperti yang di tunjukkan pada Tabel 3.1 

berikut ini: 
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Tabel 3.2 : Penetapan komponen  (bahan) 

No. Komponen No. Komponen 

1 Modul Arduino Uno 14 PCB Matrik Strip Board 

2 Sensor Ultrasonik HC-SR04 
15 Pompa Mini AC 200V/240V 

50Hz 15W 
3 Galon Plastik  16 Steker Listrik 
4 Papan Akrilik 17 Resistor 2K2 
5 Modul Relay 1 Channel 5 VDC 18 Spicer Besi 
6 LCD 16x2 19 Kabel Pelangi 
7 AC-DC Adaptor 12 V 20 Pipa PVC AW ½”  
8 PCB Bolong 21 Elbow Pipa 
9 Miniature LED  22 Tee T ½” 
10 Kran Air Plastik 23 Dop Pipa ½” 
11 Pot Tanaman 24 Drip Head Putar 
12 Drip Selang 25 Selang Drip 5 mm 
13 Lem Pipa PVC 26 Konektor Nepel Ulir 5 mm 

 

3.2.2. Rancangan Struktural 

a. Galon Air  

Galon air dalam penelitian ini berfungsi sebagai tempat penampungan air 

untuk irigasi tetes atau yang dalam hal ini masih dalam ukuran kecil. Adapun 

galon air yang digunakan adalah berbahan plastik dengan bentuk silinder dan 

volumenya sebesar 4622,08 cm3   

Adapun volume galon air tersebut dapat diuraikan sebagai berikut :  

Tinggi tabung =  23 cm 

Radius tabung  =  8 cm 

Maka secara rumus : 

 V =         

     = 3,14 x 8 cm  x 8 cm x 23 cm 

     = 4622,08 cm3 
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Selanjutnya galon ini didesain bagian permukaannya sedemikian rupa seperti 

pada Gambar 3.2 dengan tujuan untuk meletakkan sensor ultrasonik HC-

SR04 dengan tujuan agar sensor dapat mendeteksi seberapa besar permukaan 

air yang akan dikendalikan dalam tujuan penelitian ini dan pada sisi dinding 

tabung bagian bawah dengan posisi bagian luar juga dipasang keran air yang 

difungsikan untuk mengontrol secara manual sejumlah air yang dikeluarkan 

menuju pipa irigasi. 

Adapun desain ataupun rancangan galon air ini dapat dilihat pada Gambar 3.2 

berikut ini: 

 

8 cm

23 cm

Galon Air

Sensor HC-SR04

Keran Air

Selang 

Pompa Air

 

Gambar 3.2 : Rancangan Galon Air Beserta Keran Dan Letak Sensor. 

 
 Selanjutnya berdasarkan Gambar 3.2 di atas dilakukan proses pembuatan 

rancangan galon air tersebut dengan menggunakan peralatan gerinda listrik, 

kikir, bor listrik, dan obeng. Sedangkan untuk bahan yang diperlukan adalah 
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galon air, keran air, selang pompa, papan akrilik, baut dan mur serta 

sambungan selang drat. 

 Prosedur pembuatan : 

 1. Memotong bagian atas mulut galon menggunakan alat gerinda listrik 

sebagai tempat peletakan sensor ultrasonik HC-SR04. 

 2. Melobangi bagian dinding sisi atas galon menggunakan bor listrik 

dengan diameter lubang 15 mm sebagai peletakan sambungan selang 

drat. 

 3. Memasang keran air pada bagian bawah dinding galon dimana terlebih 

dahulu membuat lubang menggunakan bor listrik dengan diameter 

lubang 10 mm sesuai ukuran drat keran air. 

 4. Menyiapkan papan akrilik dan dipotong menggunakan gerinda listrik 

sesuai ukuran dan bentuk papan modul sensor ultrasonik HC-SR04, serta 

memberikan lubang setiap sudut papan akrilik dengan ukuran mur yang 

tersedia yaitu 1 mm, lalu mengikatnya dengan mur tersebut.  

 5. Melobangi pada bagian pinggir permukaan mulut galon sebesar diameter 

mur yakni 1 mm dan terakhir adalah memasang sensor yang sudah terikat 

pada papan akrilik pada bagian pinggir permukaan mulut galon dan 

menguncinya dengan baut-nya. 

  

 Berikut ini adalah  Gambar 3.3 yang menampilkan hasil pembuatan galon air 

sesuai prosedur di atas : 
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Gambar 3.3: Hasil Pembuatan Galon Air. 

 
b. Rak Galon Air 

 Bagian ini berfungsi sebagai tempat dudukan galon air agar galon berada 

pada posisi lebih tinggi dari pada pipa irigasinya sehingga tekanan air dalam 

galon semakin kuat untuk keluar melalui keran, selain itu juga difungsikan 

sebagai tempat galon air agar terduduk rapi dan tidak bergeser kemana-mana. 

Rak galon ini terbuat dari besi padat dengan ketebalan 5 mm tentunya 

ketebalan ini dipilih dengan tujuan menyesuaikan beban yang dipikul dan 

juga agar lebih kuat. Selanjutnya bentuk dari pada rak galon ini dirancang 

sesuai gambar di bawah ini dimana pada gambar tersebut sudah dilengkapi 

juga dengan dimensi dari setiap bentuk. Model dan dimensi yang dibuat ini 

adalah bertujuan agar alat mudah dibawa (portable) juga memberikan nilai 

estetika agar tampak lebih elegan. Gambar 3.4 berikut ini adalah gambar yang 

menampilkan rancangan bagian rak galon air tersebut : 
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18 cm

8 cm

19 cm

 

Gambar 3.4 : Rancangan Rak Galon Air. 

 
 Selanjutnya berdasarkan Gambar 3.4 di atas dilakukan proses pembuatan 

rancangan rak galon air tersebut melalui jasa pembuatan rak. Adapun tugas 

saya adalah memberikan ataupun diskusi langsung dengan tukang pembuat 

rak mengenai gambar desainnya, dan kesimpulan gambar desain raknya 

adalah sesuai Gambar 3.4 di atas.  

 Berikut ini adalah Gambar 3.5 yang menampilkan hasil pembuatan rak galon 

air yang dibuat oleh tukang jasa pembuat rak sesuai Gambar 3.4 : 

 

Gambar 3.5 : Hasil Pembuatan Rak Galon Air. 
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c.  Sistem Irigasi Tetes 

 Bagian ini berfungsi sebagai sistem irigasi yang penyalurannya menggunakan 

bahan pipa PVC merek AW dengan ukuran ½ inchi  sebagai sarana 

pendistribusian air terhadap tanaman. Selain itu menggunakan irigasi pipa 

juga lebih mudah diatur dan diukur.  

Adapun bentuk rancangan pipa sistem irigasi tetes ini dapat dilihat pada 

Gambar 3.6 berikut : 

68 cm
6 cm

10 cm
7 cm

7 cm

Selang 

Drip

Drip Head

Konektor 

Nepel Ulir

 

Gambar 3.6 : Rancangan Pipa Sistem Irigasi Tetes. 

 
 Selanjutnya berdasarkan Gambar 3.6 di atas dilakukan proses pembuatan 

rancangan pipa sistem irigasi tetes tersebut dengan menggunakan peralatan 

gerinda listrik, gergaji pipa, bor listrik, dan tang. Sedangkan untuk bahan 

yang diperlukan adalah pipa PVC merek AW ukuran ½ inchi, tee T, elbow, 

drip head putar, selang drip, konektor nepel ulir 5 mm, dop pipa ½ inchi, dan 

lem pipa PVC . 

 Prosedur pembuatan : 

 1. Memotong pipa PVC menggunakan gergaji pipa sesuai ukuran masing-

masing bagian sesuai Gambar 3.6 di atas. 
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 2. Melubangi bagian badan pipa yang paling panjang menggunakan bor 

listrik sebagai tempat peletakan konektor nepel ulir dengan diameter 

lubang 5 mm. 

 3. Menyambungkan setiap bagian pipa yang telah dipotong sesuai ukuran 

dengan menggunakan lem perekat yaitu lem pipa PVC. 

 4. Terakhir adalah menyambungkan selang drip pada konektor nepel ulir 

dan head drip disambungkan dengan selang drip bagian ujung. 

 Berikut ini adalah Gambar 3.7 yang menampilkan hasil pembuatan sistem 

irigasi tetes sesuai prosedur di atas : 

 

 

Gambar 3.7: Hasil Pembuatan Sistem Irigasi Tetes. 

 
d. Dudukan Sistem Elektrikal 

 Dudukan ini berfungsi sebagai peletakan setiap sistem-sistem elektikal yang 

dirancang yang terdiri dari modul ArduinoUno, sistem monitoring (LCD 

16x2), sistem indikator Led dan modul relay 1 channel. Dudukan ini terbuat 

dari papan akrilik dengan ketebalan papan 3 mm, dan selanjutnya papan 

akrilik tersebut dirancang dan dibuat hanya dengan menggunakan peralatan 

gerinda listrik dan mistar dengan model persegi panjang dimana panjangnya 
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19 cm, lebar 14 cm. Dimensi yang dibuat adalah bertujuan agar alat mudah 

dibawa (portable) dan mudah diletakkan dimna saja. Gambar 3.8 berikut ini 

adalah gambar yang menampilkan rancangan bagian dudukan sistem 

elektrikal: 

14 cm

19 cm

 

Gambar 3.8 : Desain Dan Dimensi Dudukan Sistem Elektrikal. 

 
 Selanjutnya mengenai tata letak sistem elektrikal terhadap dudukan sistem 

elektrikal ini dapat dilihat sesuai Gambar 3.9 berikut : 

 

5

3

4 6

1

2

8

7

 

Gambar 3.9 : Desain Tata Letak Sistem. 
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Keterangan Gambar 3.9 : 

1.  Modul arduino uno 

2. Modul relay 1 channel 

3. LCD 16x2 

4. Led hijau 

5. Led kuning 

6. Led merah 

7. Motor pompa mini AC 220 V 

8. Sensor ultrasonik HC-SR04 

 
Adapun tanda panah itu menunjukkan bahwa alat nomor 7 dan 8 berada 

pada posisi luar dari dudukan sistem yang meliputi motor pompa mini AC 220 V 

(7) diletakkan di dalam wadah berisi air dengan pendeskripsian sebagai sumur 

bor-nya sedangkan sensor ultrasonik HC-SR04 (8) diletakkan pada permukaan 

mulut galon air. 

3.2.3. Rancangan Sistem Elektrikal 

Rancangan sistem elektrikal yang dimaksud adalah meliputi : 

1. Sistem AC-DC adaptor 

2. Sistem modul Arduino Uno 

3. Sistem indikator Led 

4. Sistem penampil data yaitu LCD 16x2 

5. Sistem Modul Relay 

6. Rancangan Sistem Buzer  

7. Sistem secara keseluruhan atau gabungan (combine circuit) 
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3.2.3.1. Sistem AC-DC Adaptor 

 AC-DC adaptor yang digunakan dalam penelitian ini adalah cukup 

sederhana dan tidak perlu dilakukan perancangan lagi karena cukup menggunakan 

AC-DC adaptor yang sudah siap pakai dan lebih simpel yakni dengan 

membelinya di toko penjual komponen elektronika, namun hal yang tetap harus 

diperhatikan adalah spesifikasinya tentu harus sesuai dengan kebutuhan sistem 

elektrikal yang dirancang secara keseluruhan. Berikut adalah  Gambar 3.10 yang 

memperlihatkan bentuk fisik AC-DC adaptor yang digunakan beserta 

spesifikasinya yang tertera di badan adaptor : 

 

Gambar 3.10 : AC-DC Adaptor. 

Pada Gambar 3.10 di atas yang menunjukkan bentuk fisik AC-DC adaptor 

dapat juga dilihat  skema rangkaian dalamnya seperti yang ditunjukkan pada 

Gambar 3.11 di bawah ini : 

12 V 1A

Dioda Bridge

1 A

IC 7812

15

0

 

Gambar 3.11 : Skema Rangkaian AC-DC Adaptor. 
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3.2.3.2. Sistem Sensor Ultrasonik HC-SR04 

 Sistem ini juga tidak perlu dirancang ataupun dibuat lagi karena sensor ini 

sudah ada tersedia di pasaran yang siap pakai namun yang perlu difahami dan 

diperhatikan adalah bagaimana cara kerja sensor ini dan bagaimana cara 

penginstalasian pin sensor ultrasonik HC-SR04 terhadap port modul Arduino Uno 

agar dapat berfungsi dan bekerja sebagai pendeteksi ataupun pengukur jarak 

permukaan level air dalam galon air. Berikut ini akan dijelaskan bagaimana pola 

penginstalasian pin sensor ultrasonik HC-SR04 terhadap modul Arduino Uno 

yang disajikan dalam bentuk Gambar 3.12 berikut ini.  

 

VCC 5Volt

Input ke Pin 7 

Arduino

Input ke Pin 6

Arduino

Gnd

 

Gambar 3.12 : Pola Penginstalasian Sensor Ultrasonik HC-SR04. 

Keterangan pin Gambar 3.12 : 

VCC =  5V Power Supply 

Pin sumber tegangan positif sensor atau pin 5V untuk koneksi ke 

tegangan 5V dc. 
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Trig =  Trigger/Penyulut.  

Pin ini yang digunakan untuk membangkitkan sinyal ultrasonik, dengan 

kata lain Trigger Input dipakai untuk memicu pembangkitan gelombang 

ultrasonic. Berupa sinyal ‘HIGH’ selama minimal 100 us. 

Echo =  Receive/Indikator. Pin ini yang digunakan untuk mendeteksi sinyal 

pantulan ultrasonik, dengan kata lain Echo Output untuk memantau 

kondisi logika, apakah gelombang ultrasonic sudah diterima kembali atau 

belum. 

GND =  Ground/0V Power Supply 

Pin sumber tegangan negatif sensor. 

OUT =  Mode (No Connection) 

 
3.2.3.3. Sistem Indikator Led 

Sistem indikator led pada penelitian ini adalah digunakan sebagai sinyal 

yang menyatakan secara kualitatif volume air dalam galon ataupun jarak yang 

menyatakan secara kuantitatif permukaan air terhadap sensor jarak ultrasonik HC-

SR-04. Adapun penjelasan mengenai makna dari masing-masing indikator Led 

adalah  : 

1. Led warna hijau sebagai pertanda Volume Air Full atau Jarak 

permukaan air terhadap sensor adalah  > 4  cm sampai dengan <= 6 

cm. 

2. Led warna kuning sebagai pertanda Volume Air Low atau Jarak 

permukaan air terhadap sensor adalah > 20 cm  sampai dengan <= 25 

cm. 
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3. Led warna merah sebagai pertanda Volume Air Error atau Jarak 

permukaan air terhadap sensor adalah < 0 cm sampai dengan < = 4  

cm. 

 Adapun rangkaian yang dibuat untuk  sistem indikator Led dapat dilihat 

seperti Gambar 3.13 berikut ini : 

Resistor 2K2 Ω

Resistor 2K2 Ω

Resistor 2K2 Ω

Gnd

Ke Pin 5 

(Arduino)

Ke Pin 4 

(Arduino)

Ke Pin 3 

(Arduino)

    

Gambar 3.13 : Rangkaian Sistem Indikator Led. 

 
3.2.3.4. Sistem Penampil Data (LCD 16x2) 

 Fungsi dari sistem ini adalah sebagai penampil data berupa informasi dari 

volume secara kualitatif dan jarak permukaan air terhadap sensor secara 

kuantitatif pada galon air dan hal ini merupakan  bentuk tulisan dan bukanlah 

dalam bentuk sinyal tegangan atau arus namun telah dirubah olehnya data 

tegangan menjadi suatu tulisan yang tertampil dilayarnya. Sedangkan tulisan yang 

tampil tergantung dari tulisan yang dibuat pada program yang dibuat. 
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 Dalam penelitian ini perlu diketahui bagaimana pola penginstalasian LCD 

16x2 terhadap port I/O Arduino Uno agar dapat bekerja dan berfungsi sebagai 

LCD  penampil data. Berikut adalah Gambar 3.14 yaitu pola penginstalasian LCD 

16x2 terhadap Arduino Uno : 

 

Display LCD 2x16

Source AC-DC 

Adaptor 12 VDC

 

Gambar 3.14: Pola Instalasi LCD 16x2 Pada Arduino Uno. 

 
3.2.3.5. Rancangan Sistem Modul Relay 

 Sistem modul relay dalam penelitian ini berfungsi sebagai switching 

terhadap On/Off pompa mini AC 220 V, karena apabila proses mengaktifkan 

pompa mini AC ini menggunakan sebuah modul Arduino Uno adalah tidak bisa, 

sebab input dari pompa mini ini adalah menggunakan tegangan 220 V AC 

sedangkan Ouput dari modul Arduino adalah tegangan DC. Oleh karena itu untuk 

dapat mengaktifkan modul relay ini seiring dengan perintah dari Arduino maka 

digunakanlah perantara switching dengan menggunakan modul relay. Artinya jika 

modul relay dikendalikan atau diaktifkan oleh modul Arduino maka pompa akan 

aktif juga karena modul relay membutuhkan tegangan aktif  DC sudah  sehingga 
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dapat dijadikan sebagai penghubung tegangan 220 VAC ke pompa mini sehingga 

aktifnya pompa mini sesuai aktif dan non aktifnya  modul relay ini.  

 Adapun rancangan instalasi dan sambungan antara port dari modul relay 

ini terhadap pompa mini dan modul Arduino Uno adalah seperti yang ditunjukkan 

pada Gambar 3.15 berikut ini: 

Modul Relay 5VDC

PORT 5VDC

PORT 2PORT GND

PLN 220 VAC

Pompa Mini 220 VAC

Terminal 

COM

Terminal 

NO

 

Gambar 3.15 : Sistem Modul Relay Dengan Pompa. 

 

 
3.2.3.6. Rancangan Sistem Buzer 

 Sistem buzer dalam penelitian ini adalah berfungsi sebagai indikator atau 

penanda ketika volume air pada galon penampungan melebihi ambang batas yang 

sudah ditentukan. Untuk membuat rancangan sistem buzer pada penelitian ini 

adalah cukup sederhana yakni cukup dengan membeli modul buzer yang sudah 

tersedia di toko elektronika. Sedangkan hal yang tetap perlu diperhatikan adalah 

cara penyambungan ataupun pasangan sambungan yang sesuai pada masing-

masing pin arduino dengan pin modul buzer, sebab jika tidak sesuai 

penyambungannya maka akan mengakibatkan kesalahan sehingga sistem tidak 
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dapat berfungsi. Berikut adalah Gambar 3.16 yang menampilkan hubungan 

sambungan anatar pin arduino dengan pin modul buzer. 

 

Gambar 3.16: Sambungan Sistem Buzer Terhadap Arduino. 

 

 

3.2.3.7. Sistem Minimum Arduino Uno 

 Sistem minimum Arduino Uno yang digunakan pada penelitian saya ini 

adalah seperti yang ditunjukkan pada Gambar 3.17 di bawah ini , dimana sistem 

minimum ini sudah dirancang oleh pabrikan pembuat modul Arduino. Adapun 

kegunaan dari sistem minimum Arduino ini adalah sebuah rangkaian yang paling 

penting karena berguna untuk dapat menjalankan dan memprogram IC 

mikrokontroler Atmega 328A sebagai sistem kendali terhadap beban yang akan 

dikontrol oleh modul Arduino. Sistem minimum ini adalah sebuah rangkaian 

paling sederhana dari sebuah mikrokontroler agar IC mikrokontroler tersebut bisa 

beroperasi dan diprogram. Untuk lebih jelas berikut adalah  gambar yang 

----------------------------------------------------- 
© Hak Cipta Di Lindungi Undang-Undang 
----------------------------------------------------- 
1. Dilarang Mengutip sebagian atau seluruh dokumen ini tanpa mencantumkan sumber 
2. Pengutipan hanya untuk keperluan pendidikan, penelitian dan penulisan karya ilmiah 
3. Dilarang memperbanyak sebagian atau seluruh karya ini dalam bentuk apapun tanpa izin Universitas Medan Area

Document Accepted 4/8/22 
 
 
 
 

Access From (repository.uma.ac.id)4/8/22 
 
 
 

Access From (repository.uma.ac.id)

UNIVERSITAS MEDAN AREA

Rahmat Timotius Gulo - Rancangan Sistem Kendali Otomatis Pengatur Volume Air



54 
 

 

menunjukkan skema rangkaian dari sistem minimum Arduino Uno beserta 

mikrokontroler ATMega 328 yang digunakan dalam penelitian ini: 

 

 

Gambar 3.17 : Sistem Minimum Arduino Uno. 

 

 

3.2.3.7. Sistem secara Keseluruhan 

Dalam perancangan dan pembuatan sistem secara keseluruhan ini artinya 

adalah seluruh komponen pembentuk sistem kendali otomatis pengatur volume air 

pada botol sistem irigasi tetes tanaman cabai berbasis arduino akan dilakukan 

penggabungan seluruh sistem elektrikal. Berikut Gambar 3.18 yang menampilkan 

skema rangkaian seluruh sistem. 
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Display LCD 2x16

Source AC-DC 

Adaptor 12 VDC

Resistor 2K2 Ω

Resistor 2K2 Ω

Resistor 2K2 Ω

Sensor Ultrasonik HY-SRF05

Indikator LED

Modul Relay 5VDC

PLN 220 VAC

Pompa Mini 220 VAC

 

Gambar 3.18 : Skema Rangkaian Seluruh Sistem. 

 

 

Selanjutnya berikut ini ditampilkan gambar hasil pembuatan alat secara 

keseluruhan yang dapat dilihat pada Gambar 3.19 berikut ini : 

 

----------------------------------------------------- 
© Hak Cipta Di Lindungi Undang-Undang 
----------------------------------------------------- 
1. Dilarang Mengutip sebagian atau seluruh dokumen ini tanpa mencantumkan sumber 
2. Pengutipan hanya untuk keperluan pendidikan, penelitian dan penulisan karya ilmiah 
3. Dilarang memperbanyak sebagian atau seluruh karya ini dalam bentuk apapun tanpa izin Universitas Medan Area

Document Accepted 4/8/22 
 
 
 
 

Access From (repository.uma.ac.id)4/8/22 
 
 
 

Access From (repository.uma.ac.id)

UNIVERSITAS MEDAN AREA

Rahmat Timotius Gulo - Rancangan Sistem Kendali Otomatis Pengatur Volume Air



56 
 

 

 

Gambar 3.19: Bentuk Fisik Hasil Pembuatan Alat Secara Keseluruhan. 

 

3.3. Flowchat Sistem Kerja Alat 

 Berikut ini adalah Gambar 3.20 yang menampilkan flowchart sistem kerja 

alat yakni bagaimana alur kerja dari rangkaian seluruh alat sehingga dapat 

berfungsi sebagai sistem kendali otomatis pengatur volume air pada botol sistem 

irigasi tetes tanaman cabai berbasis arduino. 
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MULAI

SENSOR 
MEMBACA JARAK 
PERMUKAAN AIR

SELESAI

TIDAK

YA

Tampilan LCD :
Jarak = 21 cm

Volume Air Low

Indikator :
Led Kuning MenyalaPompa Hidup

Apakah Jarak
> 20 &&  <= 25

TIDAK

TIDAK

YA

Tampilan LCD :
Jarak = 5 cm

Volume Air Full

Indikator :
Led Hijau MenyalaPompa Mati

Apakah Jarak
> 4 &&  <6

TIDAK

YA

Tampilan LCD :
Jarak = 4 cm

Volume Air Error

Indikator :
Led Merah Menyala

Apakah Jarak
> 0 &&  <= 4

TIDAK

Buzer Hidup

 

Gambar 3.20: Flowchat Sistem Kerja Alat. 
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BAB V 

KESIMPULAN DAN SARAN 

 

5.1. Kesimpulan 

Berdasarkan hasil rancang bangun dan pengujian alat serta pembahasan 

pada bab terdahulu maka dapat disimpulkan bahwa:  

1. Alat yang dirancang ini telah dapat dibuat sesuai tujuan penelitian yakni dapat 

berfungsi sebagai alat pengendali otomatis pengatur volume air pada botol 

atau galon air penampung sistem irigasi tetes tanaman cabai. 

2.  Kerja on/off pompa berdasarkan volume air pada botol penampungan melalui 

pendeteksian jarak permukaan air terhadap sensor dapat diatur melalui sketch 

program Arduino yang dibuat. 

3.  Pengendalian irigasi tetes dapat dilakukan dengan melihat kinerja alat yang 

dapat mengendalikan volume air dalam galon sehingga airnya selalu tersedia 

di dalam galon selama alat masih dialiri oleh listrik. 

4. Sensor ultrasonik HC-SR04 telah diaplikasikan sebagai alat pendeteksi 

volume air melalui jarak 21- 5 cm dari permukaan air terhadap muka sensor. 

5.  Makin rendah kerapatan (density) zat pemantul gelombang ultrasonik maka 

makin besar kesalahan relatif maksimum alat ukur jarak menggunakan sensor 

HC-SR04 (untuk jenis air). 

5.2. Saran 

Jika mengaplikasikan alat ini pada lahan terbuka sebaiknya sumber energi 

listriknya menggunakan panel surya agar lebih efisien karena biasanya di 

lahan terbuka tidak ada jaringan listrik PLN. 
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DAFTAR LAMPIRAN PERANCANGAN DAN PEMBUATAN ALAT 

 

 

 
 

Lampiran 1: Pengukuran Pipa PVC Untuk Saluran Air Irigasi Tetes. 

 

 

 
 

Lampiran 2: Pemotongan Pipa PVC Untuk Saluran Air Irigasi Tetes. 
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Lampiran 3: Pengukuran Jarak Setiap Lubang Irigasi. 

 

 

 
 

Lampiran 4: Pengeboran Lubang Yang Telah Diberi Jarak. 
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Lampiran 5: Pengukuran Panjang Selang Drip. 

 

 

 
 

Lampiran 6: Pemasangan Selang Drip Terhadap Pipa PVC. 
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Lampiran 7: Perangkaian Instalasi Pipa PVC Dengan Selang Drip. 

 

 

 
 

Lampiran 8:  

Pemasangan Instalasi Tabung Air Dengan Selang Pompa Dan Sensor Ultrasonik. 
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Lampiran 9: Proses Pengeleman Dengan Menggunakan Lem Tembak. 

 

 

 
 

Lampiran 10: Instalasi Seluruh Sistem Mekanik. 
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Lampiran 11: Penyolderan Kabel Pada LCD. 

 

 

 
 

Lampiran 12: Penyolderan Instalasi Kabel Arduino Dengan LCD. 

 

----------------------------------------------------- 
© Hak Cipta Di Lindungi Undang-Undang 
----------------------------------------------------- 
1. Dilarang Mengutip sebagian atau seluruh dokumen ini tanpa mencantumkan sumber 
2. Pengutipan hanya untuk keperluan pendidikan, penelitian dan penulisan karya ilmiah 
3. Dilarang memperbanyak sebagian atau seluruh karya ini dalam bentuk apapun tanpa izin Universitas Medan Area

Document Accepted 4/8/22 
 
 
 
 

Access From (repository.uma.ac.id)4/8/22 
 
 
 

Access From (repository.uma.ac.id)

UNIVERSITAS MEDAN AREA

Rahmat Timotius Gulo - Rancangan Sistem Kendali Otomatis Pengatur Volume Air



94 
 

 

 
 

Lampiran 13: Penginstalasian Arduino Dengan Modul Relay Dan Indikator LED. 

 

 

 
 

Lampiran 14: Penginstalasian Lanjutan. 
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Lampiran 15: Bentuk Fisik Hasil Instalasi Seluruh Sistem Elektrikal. 
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LAMPIRAN CODING ARDUINO 

 

// pin LCD 
#include<LiquidCrystal.h> // library  
LiquidCrystal lcd (13,12,11,10,9,8); // set pin LCD 
 
//pin Ultrasonik 
#define trigPin 7 
#define echoPin 6 
 
int lederror = 5; 
int ledlow = 4; 
int ledhigh = 3; 
int pompa = 2; 
int buzer = A0; 
 
void setup()  
{ 
  Serial.begin(9600); 
   lcd.begin(16, 2); 
  
   
  pinMode(trigPin, OUTPUT); 
  pinMode(echoPin, INPUT); 
  
  pinMode(lederror, OUTPUT); 
  pinMode(ledlow, OUTPUT); 
  pinMode(ledhigh, OUTPUT); 
  pinMode(pompa, OUTPUT); 
  pinMode(buzer, OUTPUT); 
      
      digitalWrite(lederror, LOW); 
      digitalWrite(ledlow, LOW); 
      digitalWrite(ledhigh, LOW);  
      digitalWrite(buzer, HIGH); 
   
   delay(1000); 
} 
 
void loop() 
{ 
  int duration, distance; 
  digitalWrite(trigPin, HIGH); 
 
  delayMicroseconds(1000); 
  digitalWrite(trigPin, LOW); 
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  duration = pulseIn(echoPin, HIGH); 
   
distance = duration * 0.034/2;  
Serial.println("cm: "); 
Serial.println(distance); 
 
lcd.setCursor(0,0); 
lcd.print("Jarak =  "); 
lcd.print(distance);  //Menampilkan jarak pada LCD 16X2 
lcd.print("  cm"); 
 
if(  (distance > 0) && (distance <= 4)  )  //Batas Ambang 
{ 
lcd.clear(); 
lcd.setCursor(0,0); 
lcd.print("Jarak =  "); 
lcd.print(distance);  //Menampilkan jarak pada LCD 16X2 
lcd.print("  cm"); 
 
digitalWrite(lederror, HIGH); 
digitalWrite(ledlow, LOW); 
digitalWrite(ledhigh, LOW); 
digitalWrite(buzer, LOW); 
 
lcd.setCursor(0,1); 
lcd.print("Volume Air Err"); 
} 
 
 
if(  (distance > 4) && (distance < 6)  )   //Kondisi Full 
{ 
lcd.clear(); 
lcd.setCursor(0,0); 
lcd.print("Jarak =  "); 
lcd.print(distance);  //Menampilkan jarak pada LCD 16X2 
lcd.print("  cm"); 
 
digitalWrite(lederror, LOW); 
digitalWrite(ledlow, LOW); 
digitalWrite(ledhigh, HIGH); 
digitalWrite(pompa, HIGH); 
digitalWrite(buzer, HIGH);  
lcd.setCursor(0,1); 
lcd.print("Volume Air Full"); 
} 
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else if(  (distance > 20) && (distance <= 25)  )   //Level Low 
{ 
lcd.clear(); 
lcd.setCursor(0,0); 
lcd.print("Jarak =  "); 
lcd.print(distance);  //Menampilkan jarak pada LCD 16X2 
lcd.print("  cm"); 
 
digitalWrite(lederror, LOW); 
digitalWrite(ledlow, HIGH); 
digitalWrite(ledhigh, LOW); 
digitalWrite(pompa, LOW);  
digitalWrite(buzer, HIGH);  
lcd.setCursor(0,1); 
lcd.print("Volume Air Low"); 
} 
delay(500); 
} 
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